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Five Hidden Tools on Ancestry 
Here are some of the tools often missed by genealogist but are often overlooked.  

Link to the video: https://youtu.be/t99DXctd3wg  

1. Search Private Trees – Anyone can search for private trees, but you will not be able to see inside 
the trees until you get permission from the tree owner.    

• Go to search> Public Member Trees> Private Trees (Right side column)> 
• Search the Ancestors Name.   
• Contact the Tree owner for the results that look promising by clicking on “Contact Tree Owner.” 

2. Search Card Catalog by Location and Era – Most start their search from the ancestor’s 
search screen.  To find additional record and results, start your search from the Card Catalog and then drill 
down by location and era. 

• From the home page, click on Search tab (top of the screen). 
• Drop down to Card Catalog 
• In the left side column, scroll down to the country you are researching, then the state or province. 
• Choose a decade or century in which you are researching. 
• The results will be a list of records that Ancestry has for that location and era. 
• Note the number of results at the top of the page.  You may need to drill down further to the 

county or town in which you are researching.  However, do not forget that your ancestor might be 
listed in statewide records, so filtering to the county level may filter out possible records. 

• You can also sort by record count to review the record sets that have the most records to help 
increase your 
odds of finding 
your ancestor. 

• Example Shown: 
You would then 
pick the record 
sets you wish to 
research and 
search by the 
ancestor name, 
using all spelling 
variations. 

• Use X to remove 
filter. 

https://youtu.be/t99DXctd3wg


 
 

 

Copyright © 2021 – Constance H. Knox 

3. All Hints – Using the All Hints 
feature you can then search by 
ancestor. 

• Click the Leaf icon in the upper 
right corner on almost any 
page. 

• At the bottom of the list click 
“See all recent hints in…” 

• Choose a tree if you have 
more than one. 

• Note how many hints in this 
view. 

• Choose “Filter by Name” and 
search your target ancestor. 

• Add sort by Last Name if you choose. 
• Also see the dropdown arrow on the upper right corner to learn 

more about a specific hint’s family.    

 

4. See Who Saved Your Images and Documents – Great way to connect! 

When you upload documents and images to your public tree, others can see and save your contributions to 
the world.  By looking at who has saved your documents and images in your family tree, it is a great way to 
find other persons researching the same family lines.   

• Go to the profile view of your ancestor. 
• Click on Gallery 
• Choose an image or document you have 

uploaded. 
• Look at the “Saved by” area.   
• Click on the circles to see who saved your 

images.   
• You can contact them directly to collaborate on the family history by clicking on their name. 
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5. Ethnicity Estimates – Additional Communities gives you a migration timeline. 
• Click on DNA Tab>Your DNA Results 
• Click on “Discover Your DNA Story” button in the DNA Story box. 
• On the right-side box labeled 

Ethnicity Estimate, look for 
Additional Communities (if 
available). 

• Click on one of the Additional 
Communities and a timeline will 
appear.  

• As you scroll down in the right-
side column, the map view will 
change and animate. Watch the 
timeline grow with the 
information in the right-side 
column.  
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Ancestry’s New Features 
April-May 2021 

Rolling out in April and May 2021 there are several new features and improvements to the Ancestry 
platform. Below they are the Ancestry new features discussed in this episode on Genealogy TV. 

Ancestry Messaging System  
Ancestry has been aware for years that they have issues with their messaging system, primarily with 
speed.  However, they did report recently that they are working on bug fixes, response rate, and the 
monthly update.  

Sending Photos via Email 
Ancestry allows you to attach a photo to 
a message, but with two criteria.  One is 
that it must be of a deceased person. 
Two, it must have been uploaded to the 
gallery on that ancestor’s profile on 
Ancestry.com.  Simply go to the gallery, 

select a photo and at the bottom, click share to an email address. 
This does not work for documents, just photos. 

 

 

PhotoLine 
Coming soon (possibly May 2021) for mobile app users only.  You will be able to 
compare your own photo to that of your ancestors.  Here you can compare yourself 
with your parent or grandparent of the same sex.  Therefore, if you are female, you 
can compare your image to that of your mother or grandmother.  
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DNA Matches 
Ancestry has rolled out a new feature that allows for a faster workflow when grouping DNA Matches.   

When Grouping your DNA matches, Ancestry has added the ability to bulk your groups without having to 
edit each individual match.  Now you can click the pencil icon on the right side of any cousin match, click 
“Add to Group” and check multiple cousins at one time to add them to a specific group.  See this video 
more on Grouping your DNA Cousin Matches on Ancestry. 

Hinting  
Ancestry has been working hard to 
improve the hinting features. The 
side panel has been a huge 
improvement.  The goal for 
Ancestry is to help us evaluate the 
evidence instead of just 
automatically importing it.  As 
such, they have added a side panel 
recently and now have added a 
resizing function of that panel.  
Clicking the arrows (shown in the 
red box) allows for expansion of 
the side panel. 

Additionally, Ancestry has added the “Compare Details” to this side panel. This to 
can be expanded on contracted allowing for addition information on the screen.  
This is especially helpful for members using one computer screen. 

  

https://youtu.be/ErWHYCLjjxM
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Ancestry has added an “Edit All” button 
in the side panel as well.   

This allows you to edit all the details right 
in the side panel as you are importing the 
new record, without needing to open a 
new screen.  This expands the view to 
see the details in your tree along side the 
data from the record.  

This too can expand this window wider, 
as previously mentioned. 

As a side note, to see All Hints you have 
for your entire tree, scroll to the bottom 
of your hints page, and click on the link in 
this message where it says, “View Hints 
for Others.” 

 

 

StoryScout™  
Now moved under the Trees tab. StoryScout™ is now 
available in the UK, Australia/New Zealand.  It is due to 
launch in Canada in 2021. Ancestry plans to add more 
geographic areas in 2022.  

For all who have current access to 
StoryScout™, a new feature has been 
added to allow you to add stories 
from StoryScout™ directly into your 
ancestor’s profile. 

StoryScout™ has a new feature where 
you can save a StoryScout™ story 
directly to the ancestor in your tree.  

Clicking the “Save this information” 
button will send it directly into the 

timeline of your ancestor’s profile in both the Facts and Life Story area.  



Genealogy TV 

GENEALOGY TV © 2021 CONSTANCE HENLEY KNOX 

 

4 

New MyTreeTags™ 
Ancestry has added a section of Tree Tags called Life Experience Tags 
to help note enslaved, slave owners, military service, royalty and 
more.  

To open MyTreeTags, click on 
the pencil icon under the 
ancestors name (in the 
Profile View or from the Tree 
View) click on the person, 
then edit from the mini 
menu.  

 

As always you can customize Tree Tags if you don’t see a tag that 
fits.  

 

  

 

New Records from the Danish West Indies  
New Records from Danish West 
Indies (U.S. Virgin Islands today) 
became available for free and 
enslaved individuals on April 12th, 
2021. They include records Danish 
language records from Enslaved 
people, 1625-1904, Birth Marriage, 
and Death Records (1820-1909), and 
Records and Documents of General 
Governance, 1755-1916.  These 
records are indexed in English, but 
images are beautiful handwritten in 
Danish.   Go here for a Danish to 
English word list, compliments of 
FamilySearch.org. 

https://www.familysearch.org/wiki/en/Danish_to_English_Genealogical_Word_List
https://www.familysearch.org/wiki/en/Danish_to_English_Genealogical_Word_List
https://www.familysearch.org/wiki/en/Danish_to_English_Genealogical_Word_List
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Black History 
Ancestry has a great section of their website to help you get started with your African American 
genealogy.  This page is designed for those who are looking for a place to get started.  While this is not a 
new feature at Ancestry, it was mentioned in this episode.   This page can be found at 
https://www.ancestry.com/cs/african-american. 

 

 

https://www.ancestry.com/cs/african-american.
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Genealogy TV’s Best 5  
Places for Genealogy Research in 

2021  
By Connie Knox 
All these services (accept one) have an overlap of the same records such as U.S. Census, Social Security 
Death Index, and other freely accessible records.  However, all have something unique to offer and no 
one service has everything. Below are the Genealogy Top 5 Online Research sites for 2021 in reverse 
order. VIDEO LINK 

#5 WikiTree  

WikiTree.com 

WikiTree is new on my list of “Go To” places. 
WikiTree is free to everyone. No subscription will ever be charged.  

WikiTree has a world collaborative tree, but now requires some form of evidence before adding a new 
person. This helps minimize mistakes in the one huge collaborative tree. The amount of detail and 
resources shown on WikiTree is huge and growing every day.  

WikiTree does not host any records. They do show where the records are located on the other services 
within the ancestor profiles, created by users. 

One of the coolest features I like is the variety of tree views.  They have a ton 
of different ways to colorize them.  However, it’s not so easy to find, so here 
is how you get to the fan chart.  You can colorize it a ton of different ways.  

Go to the MyTree tab, drop down to Family Tree & Tools, scroll past the tree to a box with the tab 
Genealogy Research highlighted, down to Fan Chart. Then once the fan chart appears, you can change 
the generations at the top of the screen. You can also see a variety of settings across the top. Hover over 
Colour Options. Choose Repeats to show duplicated ancestors. 

WikiTree Support: Help tab, drop down to G2G which means 
Genealogist to Genealogist and check out their mentorship program 
(also under the help tab).  

Here is an episode about How to use WikiTree. 

https://youtu.be/BGeeqQb-TQk
https://youtu.be/eqUlQ0dxsgk
https://youtu.be/eqUlQ0dxsgk
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#4 FindMyPast  
FindMyPast.com 

FindMyPast specializes in UK and Irish records. 
However, they also have records for Australia & New 
Zealand, and the United States & Canada. 

They are becoming increasingly more popular for genealogists in the United States when searching 
ancestors who emigrated from the UK or Ireland.  They host 8 billion records in total. 

They have Birth, Marriage, Death, Church, Education, Travel & Migration, Military, Census, Land, 
Organizations, Newspapers, and the 1939 Register & Map. 

 

Here is video about how to use FindMyPast in an interview with 
Alex Cox, produced in September 2020. 

 
Find All Record Sets at FindMyPast 

• Login and go to Search Tab, then drop down to All Record Sets (right side of the box). 
• Filter by country to help narrow results. 
• Filter by date if needed. 

FindMyPast Support - Available between 10:00 AM and 4:00 PM (BST – British Summer Time). 

• Email Support support@findmypast.com 
• Phone Support 1-855-246-8234 

https://youtu.be/9uJzTCV7K0Y
mailto:support@findmypast.com
https://youtu.be/9uJzTCV7K0Y
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#3 FamilySearch 
FamilySearch.org 

Own by The Church of Jesus Christ Latter 
Day Saints, FamilySearch is arguably a 
huge family history resource along with 
their physical Family History Libraries and associated libraries around the world.  

FamilySearch Tree 
FamilySearch has 1.36 billion ancestors in one giant collaborative tree.  It is their mission to preserve 
family history and they are very passionate about it.   

Family History Libraries 
Their family history libraries are the largest family history repositories in the world.   

Records on FamilySearch.org 
Most of their holdings both online and in their FHL libraries are cataloged and available to search on 
FamilySearch.org.  They do host 14 billion records, images, and digital books online. 

If you find a record or index without an image, take note of the FHL number, and seek the microfilm for 
it at the closest Family History Library (FHL) in your area.  Not everything is imaged, but much of it was 
originally microfilmed and is continuing to come online every day. 

FamilySearch Wiki 
The FamilySearch Wiki is one of their 
strongest assets.  This is my first “go to” 
place anytime I am wondering where to find 
a record.  

DNA - No 
You should know that FamilySearch does 
not have any DNA services.  

Support for FamilySearch 
Go here for support including phone numbers 
worldwide.  

For U.S. and Canadian Support in English Monday-
Friday 9am-5pm; Saturday 9am-2pm, closed Sunday 
1-866-406-1830. 

Here is the latest video about FamilySearch on 
Genealogy TV, called the Guide to FamilySearch. 

https://www.familysearch.org/help/helpcenter/article/contact-familysearch-support
https://www.familysearch.org/help/helpcenter/article/contact-familysearch-support
https://youtu.be/eRHmplbcT6A
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#2 MyHeritage 
MyHeritage.com 

MyHeritage is not to be ignored and raises 
to my #2 pick this year.  They have some of the best tools for genealogy research that are unmatched by 
anyone else.  MyHeritage now has 5 billion Ancestor Profiles, 91 million users, 14.5 billion historical 
records, and 5.1 million DNA kits. 

Records & Profiles 
Just like the other services, they have family trees, ancestor profiles, and tons of records to search.  
What is unique is the way they display their data, most unique DNA 
tools, and photo enhancements that no one else has.   

Photo Enhance & Animation 
Starting with their photo enhancing tools, you can immediately 
repair images, remove cracks, or animate from still portrait images, 
with a click of the mouse. 

DNA – Yes! 
Two unique DNA tools that MyHeritage has is the AutoClusters 
and the Chromosome Browser.  These tools help you to dig 
deeper into your DNA research.  

AutoClustering helps you group your DNA cousins visually.  

The chromosome browser shows you what parts of each 
chromosome you share with your DNA cousins.  

 

MyHeritage Support 
For USA Phone Support 1-844-994-1888. 
For all Countries - Phone Support  
 

Here are episodes about MyHeritage and How to Use MyHeritage and the MyHeritage DNA services, 
hosted by Daniel Horowitz.  

https://www.myheritage.com/contact-myheritage
https://youtu.be/hWJBFSG6S5c
https://youtu.be/yI1T7ZRlxHQ
https://youtu.be/hWJBFSG6S5c
https://youtu.be/yI1T7ZRlxHQ
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#1 Ancestry 
Ancestry.com 

Records 
Ancestry is my top pick for several 
reasons. First of the number of records they hold, at 30 billion, are easily searched from several places 
on across the platform. 

DNA 
The fact that they have the most DNA tests worldwide at 20 million test kits. 

While Ancestry’s Thrulines® isn’t perfect, it does show how your DNA cousins may be related to you. 

Searching for Records on Ancestry 
There are several ways to search for the records of your ancestor on Ancestry.  There are easy ways and 
smarter ways that help you dig deeper without too much effort.   

Search Buttons 
The easy ways are to use the search button while in the tree view or the ancestors profile view.  These 
are easy and fun.  There is nothing wrong with searching the easy way, but they only provide the 
obvious low hanging fruit.  What if you still can’t find the answer to your research question?  That’s 
when you turn to the Card Catalog. 

Card Catalog 
Ancestry’s hint features deliver many record hints in the form of a leaf across their platform. To find ALL 
the records that might contain your ancestor, you’ll want to search from the world-famous Card Catalog 
on Ancestry.  Searching from the Card Catalog will deliver all records Ancestry has to offer with many 
filtering options to help narrow down to the record sets that might contain your ancestor. 

 

Autofill 
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Tip! When searching any record set in the Card Catalog, Ancestry will have an autofill function as you 
begin to type your ancestor’s name (that is already in your tree).  You can choose the ancestor from the 
list or populate the search fields manually. I recommend searching both ways, because the autofill might 
fill too much information into the search fields, thus narrowing your results.  Sometimes less 
information is more results. Notice in the example above, autofill filled in two last names, her maiden 
and married name. In this search, I would not want her married name because she immigrated when 
she was single. 

Ancestry Support 
Ancestry phone and text support is 9:00 AM to 11:00 PM (eastern) Monday – Sunday. 

• Family History, Account, and Mobile phone support 1-800-615-6560 
• DNA phone support 1-880-958-9124 

 

Currently there are 62 episodes about Ancestry and how to use it on Genealogy TV.  Here is a playlist of 
all Ancestry Tips and Tricks. 

Companies Compared 
As of 8-10-21 Profiles/Ancestors DNA Test/Connections 

Family 
Trees Records Support Starting Cost/Sale 

Free 
Option 

Ancestry  13 billion   20 million   100 million  
 30 billion 
Records 
Online  

 Chat, FAQ, 
Text & Phone  

$24.99 per month  
or $119 for 6 

Months 
Yes 

MyHeritage  5 billion   5.1 million   81 million  
 14.5 billion 

Records 
Online  

 Help Center, 
Searchable 
Knowledge 

Base, Phone  

$129 per year/$89 
1st Year or  
$89 on Sale 

Yes 

FamilySearch  1.36 billion   None   1 World 
Tree  

 14 billion 
Records, 
Images 

and Digital 
Books Online  

 FS Wiki, Chat, 
phone 

worldwide  
Free Always 

Free 

FindMyPast    Uses Living DNA. No. of 
kits not available.     8 billion  

 Help Hub, 
FAQ, Email, & 

Phone  

$129/Year or 
$50 off Annual 

Rate 
Yes 

WikiTree  28 million   8.6 million   1 World 
Tree  

 No records, 
but links to 
the records 
wherever 
they are.  

 G2G Forums 
& Mentors  Free Always 

Free 

Note: Costs do not include DNA. Ancestry profiles are likely duplicated multiple times.     
 

https://youtube.com/playlist?list=PLiMXWjHlj5RTuO4UJdUB5vKqfYFuQ5qnQ
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Social Security Death Index 
Social Security Claims & Applications 

Applying for the Original SS-5 
 

The Social Security Administration was created in 1935. Your ancestors may have filled out an 
application to apply for a Social Security card shortly thereafter.  The Social Security Death Index was 
created in 1962. While many records are available from 1935 forward, most records are found after 
1962. These records are available for genealogical research for free.  

The Social Security Death Index and the Social Security Claims and Applications Index can be some of the 
most important documents that we can find when researching our family history. Applying for the 
original application (SS -5) is incredibly important when researching our family history as it provides 
additional information the indexes do not. You will always want to dig to the original records, whenever 
possible.  

When searching for your ancestors using the Social Security records, you will find two record sets. One is 
the Social Security Death Index, 1935-2014 and the other is the Social Security Applications and Claims 
Index, 1936-2007. You will want to use both indexes, as they provide a little different information.  

Social Security Death Index (SSDI), 1935-2014 
The Social Security Death Index (SSDI) 
can be found in several places and are 
free to use.  They can be found on 
Ancestry.com, FamilySearch.org, 
MyHeritage.com, and FindMyPast.com. 
This is where you will want to start and 
collect all data found for your ancestor.  
You will want to note the Social Security 
Number before moving on to the next 
step.   

Additionally, the Last Residence is not 
always the last address of your ancestor.  
It could be that of the person filing the claim or settling the estate. Either way, it may provide clues. 
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Social Security Claims and Applications Index, 1936 – 2007 
This database picks up where the SSDI 
leaves off.  You also want to search this 
index for additional information. Make sure 
to match the Social Security numbers from 
the SSDI. To ensure you have the right 
person. Only Ancestry has the Social 
Security Claims and Applications Index.  
Here you will also want to note the Social 
Security Number and extra notes at the 
bottom for variations of the ancestor’s 
name (especially for women). 

Where to find the Social Security Death Records 
On Ancestry, click the Search tab at the top of the home page, drop down to Card Catalog, and do a 
Keyword search for “SSDI.”  You will find both record sets.  Search for your ancestor after 1935 in both 
record sets. This direct link may take you there. 

On FamilySearch go to the Search tab at the top, drop down to records, in the lower right corner search 
in the “Find a Collection” field for “United States Social Security Death Index.”  This direct link may take 
you there. 

On MyHeritage, login, click Research tab at the top of the page, drop down to Collection Catalog, in the 
upper right corner search “Social Security Death” and both record sets will pop up.  This direct link may 
take you there. 

Applying for the SS-5 (Original Application) 
You should apply for the original application your ancestor filled out when they applied for a Social 
Security card.  

• Once there, choose Create Request > 
Begin > Fill out the form.  

• The Agency is the Social Security 
Administration.  

• The Contact Information is your 
information (not your ancestors).  

• Your fees should be about $27, add a 
description of what you are looking 
for such as the SS-5 and your 
ancestor’s name. More will be added below. 

• Request Type is the “Photocopy of Original Application for a Social Security Card (SS-5) of a 
Deceased Individual.” 

https://www.ancestry.com/search/collections/catalog/?keyword=SSDI
https://www.familysearch.org/search/collection/1202535
https://www.familysearch.org/search/collection/1202535
https://www.myheritage.com/research/catalog?s=574285081&q=Social%20Security%20Death
https://www.myheritage.com/research/catalog?s=574285081&q=Social%20Security%20Death
https://foiaonline.gov/foiaonline/action/public/home
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• You will need to provide a Social Security Number and the rest of the information to the best of 
your ability.   

• You can supply any supporting documentation by attaching files.  If you have any 
documentation, I suggest you attach them. 

Replies may take several weeks to 
several months depending on the 
backlog of requests. 

The information found on the SS-5 
can add to the facts for your 
ancestor, especially if their parents 
are listed.  

 

In most cases you will find: 

• Name at the time of application 
• Address.  (Note: The date of the application pins your ancestor in a place in time.) 
• Employer… and address 
• Age 
• Birthdate  
• Place of birth 
• Father 
• Mother 
• Gender 
• Ethnicity 
• Date of employment 
• Have you filled out this card before? 
• Date  
• Actual Signature (Note the signature for comparison to other records.) 

 

Addition Resources and Links: 
• Genealogy TV Video for this Handout 
• More about the Social Security Death Administration Records 
• Social Security Records on Ancestry 
• SSDI on FamilySearch 
• Social Security Applications and Claims on MyHeritage 
• SSDI on MyHeritage 

 

https://youtu.be/0BtnonBZ0RI
https://www.familysearch.org/wiki/en/United_States_Social_Security_Administration_Records#Social_Security_Death_Index_.28SSDI.29
https://www.ancestry.com/search/collections/catalog/?keyword=SSDI
https://www.familysearch.org/search/collection/1202535
https://www.myheritage.com/research/collection-10863/us-social-security-applications-claims-1936-2007?s=574285081
https://www.myheritage.com/research/collection-10002/us-social-security-death-index-ssdi?s=574285081
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Start Your Family History for Free: 
Five Step Process for  
Beginner Genealogist 

Recommendations to Get Started with Your Family Tree for Free 
April 2020 

By Constance Henley Knox 

Author's Comment:  Please know that this is not sponsored by anyone. The opinions and 
strategies are that of my own.  

What Inspired You to Start This Journey? 

As professional genealogists, we’re always talking about the “research question” as being the 
start to every research project.  So, what brought you here?  What is it that you’re curious 
about?  For some it’s finding their biological parents.  For others, it might be the desire to learn 
more about a grandparent.  For others it might be to prove or disprove family lore.   

Whatever your reason for starting your family history… know this, it is one of the most rewarding 
adventures you’ll undertake.  You’ll discover stories that read like a good book or you’ll imagine 
what it was like living in the past as if you’re watching a cinematic adventure. The cool part is that 
it’s real and it’s your family… it runs in your DNA!  It’s made you who you are today. 
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About Free Records, What’s Free and What is Not? 
 
Typically, U.S. Federal Census records, many items in libraries, and archives are free. 
However, there are a host of other companies that offer free access to some of their services 
and or records.   

 

72 Year Privacy Act 
 
You should know, due to the 72-Year Privacy Act and concerns over the privacy of living 
individuals, some records may not be available… yet.  The 72-Year Privacy Act was created in 
1978 to protect the information of living individuals. At the time it was created, 72 years was the 
average lifespan of a person.  As a result, many census records newer than 72 years, may not 
be open to the public.  For example, as of this writing, the U.S. Census records are only 
available up through 1940.  Therefore, you can access 1790-1940 census schedules today for 
free.  The 1950 U.S. Census will become public on April 1st, 2022.  

Figure 1 Christopher Madsen Family - 1910 U.S. Census, Laramie, WY. Image from family archives. 
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Where to Find Free Records 

 
 
Almost all online genealogy companies have some free records available that you can access 
right now.   
 
So, what’s free and what is not?  
Well for companies like 
Ancestry.com, 
FindMyPast.com, and 
MyHeritage.com, the general 
rule is if the company had to 
pay for rights to the records, 
then access to those records 
will be behind a paywall or 
subscription service.   
 
However, if the company was 
permitted access to already 
public records, or the 
information was obtained by 
volunteers (like you and me 
when we add data to our 
online trees) then that information is available to the public generally for free.   
 
For example, at Ancestry.com, you can search other member trees for free if the member has 
set their tree to “public.”  I highly encourage you check them out.  But more on that shortly. 
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Ready, Set, Go!  
 
Hold on to your hat… I’m going to run through a lot of information to help you find 
your ancestors for free. Feel free to rewind and watch sections of the 
accompanying video “Trace Your Family Tree for Free: Five Step Process 
for Beginner Genealogists” again if you need to take notes or missed 
something, but much of the information is provided for you in this 
eBook. 
 
You’ll be working backwards in every step of the process. Start with 
yourself, then your parents (if you know them), then your 
grandparents and so on. You’ll also take this approach with each 
person's life and timeline.   
 
You’ll start with death and burial information and work backwards in 
a person's lifetime.  The reason for this is the most information (facts 
and evidence) you find is in the most recent records.  
 
Get in the habit of reviewing every detail for accuracy.  For example 
on a death certificate, information about the deceased person’s 
parents may not be accurate, as the informant on the death 
certificate may have been distraught at the time, may not have 
known the information, or just simply got it wrong.  Question 
everything.   
 
Also know that you’ll run into conflicts about dates and the spelling 
of names.  Expect it. Make note of the discrepancies and resolve 
them once you have all the information. In some cases, you may never 
resolve the conflict.   
 
Lastly, before we get started, if you want to get the most out of your free 
options, do these steps in the order as I’ve presented them and build out as much of your family 
tree as you can in each step, before moving to the next step. 
 
Having said that, make sure you read this entire eBook before starting.  Think of it like a recipe, 
you always want to read the recipe before you start cooking. 
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STEP ONE 

BUILD A FREE TREE ON THE ANCESTRY WEBSITE 
 
If you reside or are researching in the U.S., I 
recommend you build your free tree on 
Ancestry.com as a guest account.  Why?  
Because it is your tree and only you (and those you assign as contributors) can modify it.  It’s 
your work.   
 
I recommend that you build your free tree on Ancestry.com and keep it as your Primary 
Tree. Your Primary Tree is where you’ll always keep the most up-to-date information in your 
family tree, first and foremost.  You might have other trees on other services, but your Primary 
Tree on Ancestry is the one tree you know is up to date, has all the information you’ve 
found, your notes, images and documents. 
 

Creating a free tree on FamilySearch.org, for 
example, well that’s a collaborative tree...and you’re 
adding to a world tree and it may not be accurate or 
others may change what information you’ve entered.  

Don’t get me wrong.  FamilySearch is an awesome resource, and we’ll discuss why shortly. 
 
Note: Any public user trees, no matter the company, will have errors in it.  The information in 
user trees is only as accurate as the family historian who entered it.  Also keep in mind that 
genealogists of the past, may not have had all the information that is available to us today.  
Therefore, family historians may have entered information that they knew at the time, leaving us 
a bread crumb trail to follow.   

ANCESTRY Free Trial vs. Guest Account 
 

A free trial will expire and you’ll need to give 
them a credit card to secure the “free trial” and 
then once the free trial is over, your credit card 
will be charged unless you cancel.   

 
With a “guest account”, you can use the tree building services without ever paying for it.  
 
To set up a free Ancestry Guest Account… go here. 
 
Here is my affiliate link for a Free Trial at Ancestry.com.  This will give you access to all the 
records for the duration of the free trial.  Typically, the free trial is 14 days.  If you’re following 

https://www.ancestry.com/account/create/?_ga=2.31172095.1521073232.1585690277-406646912.1585583712
https://prf.hn/click/camref:1101l4aFW/creativeref:1011l28781
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this method, don’t exercise the free trial until a later step.  See the bonus section in this 
document as to why. 

 
Per Ancestry’s support page “Because registered guest accounts 

are free, there's no need to cancel them; you will never be billed 
for a free registered guest account. Simply discontinue use 
whenever you'd like.” 

 
For more information about what you get in your free Ancestry Guest Account… Go Here. 
 
Even if you only know a few things about your family, once you start entering information into 
your tree on Ancestry, you’ll find you know more information than you realized.  Now as soon as 
you do, in a few hours, you may see those little green leaves popping up.   
 
Those are “hints that Ancestry is suggesting that they might have records that 
match your people.  Clicking on those leaves will lead you to records that may or 
may not match your ancestors. If they do, you can import them or link them to 
your tree.  If they are census records, any free-to-the-public record, or other public 
member trees, you should have access to those records for free. 
 
Just a tip… Census records will become the backbone of your genealogy!  They are wildly 
valuable. 
 

Chase all the hints you can for free.  Don’t get frustrated if Ancestry pops up and 
says you can’t access that record because you don’t have a paid subscription. 

You’ll likely see enough information in the index to know if it looks promising.  You 
should make a note of the record if it looks like a match, then mark for 
further investigation later. KEEP A LIST!  You’ll need it in a later step.  

 
As you work through the hints you have the choice to “accept” it, “ignore” it, or choose 
“undecided.”  No matter what you choose, don’t worry about making a mistake, you can always 
see those hints again, even if you ignored them. 
 
I did an entire video based on Ancestry’s own document called…  
10 Free Things on Ancestry.com.   
 

● Here’s a link to start a Free Guest Account on Ancestry.   
● Here’s a link to start a FREE TRIAL at Ancestry!  (This is a Genealogy TV affiliate link 

but costs you nothing). 
● Here’s a link to the video 10 Free Things on Ancestry.com.   
● Here’s a link to Ancestry’s documentation about 10 Free Things To Do On Ancestry. 

 
  

https://support.ancestry.com/s/article/Free-Registered-Guest-Accounts
https://youtu.be/95HrdnctZaQ
https://www.ancestry.com/account/create/?_ga=2.31172095.1521073232.1585690277-406646912.1585583712
https://prf.hn/click/camref:1101l4aFW/creativeref:1011l28781
https://youtu.be/95HrdnctZaQ
https://www.ancestry.com/corporate/sites/default/files/2001-corp-16-10-things-guide-v2.pdf
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STEP TWO  

TALK TO FAMILY!   
 
Get the family to help fill in the blanks in your tree. Collect COPIES of 
photos and records.  (See Step Four for what types of records to collect.)  
Scan or take pictures of the originals (in good light) with your cell phone 
or camera... label the files, and file them properly.   
 
Record the conversations on whatever medium you’re comfortable 
with… but do so in a quiet space… and TAKE NOTES. Don’t rely on the 
recordings. The audio may not be clear. 

 
If you can’t meet with family in person, you can set up free Skype or 
Zoom accounts to do video chats.  Just be mindful of the technical 
understanding of those you are interviewing or seek help from other 
family to help set up video chat sessions.  It’s not hard - I promise! 

 
Record the sessions either on the Skype or Zoom platform 
or use screen capture software to record the session.  
Often web camera software will have a recording option as 
another alternative. 
 
Make sure you inform all those on the call that the session 
is being recorded and how you will use that recording.  It’s 
the law, not to mention ethical. 
 

While it’s not free, consider asking the elder family to 
take a DNA test.  I’ve done a series of videos on DNA 
tests and how to use them for your family research. 
 
Here are two links about DNA Research that may be 
helpful. 

● What DNA Test Should You Take?  DNA 
Companies Compared. 

● Genealogy TV’s DNA Series of Videos 
● Ancestry DNA Test Here 

 
 
Great tips for Interviewing the family can be found in this video called:  
12 Tips for Interviewing Family, Part 1 - Learn Genealogy Series, Episode 10  
Family Interview, Part 2 (Recording) – Learn Genealogy Series, Episode 11 

https://support.skype.com/en/faq/FA11098/how-do-i-get-started-with-skype
https://support.zoom.us/hc/en-us/articles/201362033-Getting-Started-on-Windows-and-Mac
https://support.skype.com/en/faq/FA12395/how-do-i-record-my-skype-calls
https://support.zoom.us/hc/en-us/articles/201362473-Local-Recording
https://youtu.be/iNh1dBniiYw
https://youtu.be/iNh1dBniiYw
https://www.youtube.com/watch?v=tFt8YHWkvGU&list=PLiMXWjHlj5RQ_iInPLinVtIxjyzn3yE4o
https://prf.hn/click/camref:1101l4aFW/creativeref:1011l28282
https://youtu.be/NSlAUPepm40
https://youtu.be/MK2WIvcWFoY
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STEP THREE 

RESEARCH THE WORLD TREE ON FAMILYSEARCH.ORG FOR CLUES 
 

Everything is FREE at FamilySearch, even the 
records.  In this next step, research the world tree 
and its records at FamilySearch.org. Remember this 
is a collaborative tree where everyone contributes 

their data to one huge tree. Here you’re looking for clues and records about the ancestors that 
match those that you’ve entered in the tree you’re building on Ancestry.com. 
 
Remember you’re building your Primary Tree on Ancestry.com.  Right now, you’re using 
FamilySearch.org for clues and finding evidence, records, and images, etc. 
 
You can upload your tree and data on FamilySearch later.  For now, look on FamilySearch for 
information that you didn’t find (or didn’t have access to) on Ancestry. 
 
You could build a family tree on FamilySearch, but at this stage I don’t recommend it.  The 
reason is that on FamilySearch it is not your personal tree, it is one huge collaborative world 
tree and others can modify it.  For some, that can be frustrating.  Thus, I recommend you use 
Ancestry for building your Primary Tree.  We’ll talk about sharing your tree on FamilySearch in a 
later step. 
 

Also know that all public trees, on any service, are not perfect. You will find errors. 
The trees and the data in them, are only as good as the person who entered it.  

Therefore, don’t assume that just because you found it on a tree at Ancestry, 
FamilySearch, MyHeritage or any others, that it is the gospel truth.  You need to 

evaluate the evidence for yourself and build your tree based on facts, evidence, and your 
conclusions (from the evidence).   
 
If you find errors in trees, please be kind. Don’t get frustrated with the genealogy companies 
thinking it’s their fault if the data is wrong. It is likely a mistake by people like you and me who 
mistakenly uploaded the wrong information. Keep an open mind. Consider this, you might be 
wrong too.  So, before you fire off an angry note to another member, take a breath and think 
twice… again be kind.  We’re all one big happy genealogical family. 
 
If you want to reach out to another member about errors you found in their tree, take the 
approach that you’ve discovered discrepancies between their data and yours... and you’d like to 
discuss it.  This will open a dialog between you and the other member where you can exchange 
data, ideas, and evidence supporting it.  From there you can create your own conclusions. You 
never know, you may just make a new friend in the process. 
 

https://www.familysearch.org/
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Also know that you may not get a response.  This could be because they’re no longer active on 
the account or they’ve shut off notifications and never received your message.  In that case, 
they won’t see your note until they login again. It could be they may have passed away but their 
account is still online or they just choose not to respond at this time. 
 
The great part about FamilySearch is you might find some of those records that are behind the 
paywall at other subscription services (like birth, marriage, and death records). Occasionally 
you’ll find them for free on FamilySearch.  That’s why you were keeping a list of those 
records you found for further investigation, from the previous steps. You might just find 
them elsewhere for free. 
 
While searching in your 
browser you can keep 
two tabs open on your 
computer, one for 
Ancestry where your 
tree is located and one 
for the other service in 
which you're 
researching.  This way 
you can hop back and 
forth from your tree (in one 
tab) to items you’re researching (in other tabs). 
 
One trick I use a lot... is when I’m looking at a list of possible records, instead of just clicking on 
one of the links, right click and choose “open in a new tab” instead.  That way, you can open 
everything in the list that looks promising in individual tabs and close them out when you’re 
done reviewing each one methodically.  By doing it this way, it allows you to preserve your 
original list that you searched in the first tab on your browser.  
 
When you find something like a record or image that matches your ancestor, download it to your 
computer.  Keep everything filed properly so you can find it again when you need it. Keep good 
notes and files.  That’s another set of free videos I have for you. 
 
To learn about filing habits and how to take good notes, I recommend you watch:  
 

● “Research Notes” - Learn Genealogy Series - Episode 6  
 

● "Good Filing from the Start" - Learn Genealogy Series- Episode 3 
 
  

https://youtu.be/bi2Gi6YLfDk
https://youtu.be/7whvacUyLHM
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STEP FOUR 

WHAT RECORDS TO RESEARCH and WHERE TO FIND THEM? 
 
When you’re getting started and throughout your genealogical journey, what types of 
things are you looking for?   
 

START WITH YOUR OWN FILES!   
 
You likely have a ton of documents, images and heirlooms to begin your research.  Pull 
them out, copy them to a digital file and file them in surname folders.  
 
Look at each document for information like birth, 
marriage, death, divorce, burial, military, religious 
affiliations, and other family members.  Remember 
to note witnesses as they are often family or close 
friends. 

Records Online 
 
Next, you’re searching the various places 
discussed in the previous steps for:  

● Vital records (birth, marriage, death, and 
divorce) 

● Census records (federal and state) 
● Military records (indexes or actual 

records) 
● Religious (surrounding events like, births, 

baptismal/christening, burial, marriages, 
etc.) 

● Evidence of Residence (in every record 
you find) 

 

Timeline 
These are all great places to start. Along the way you’ll start building a timeline of each 
ancestor's life to give perspective and migration patterns. 
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Free Records to find might Include... 
● Census Records at Ancestry, FamilySearch, MyHeritage and Census.gov to name a 

few.  If you’ve created a tree at Ancestry, it will be easiest to search it there. 
● Look for Birth, Marriage, Death records at FamilySearch first! 
● Also Look for Evidence of Death  

○ at FindAGrave.com & BillionGraves.com... 
○ at Ancestry and FamilySearch. 

● Obituaries & Burial Records found in  
○ Newspapers at Chronicling America (part of the Library of Congress) 
○ Find-A-Grave & Billion Graves 

● Look for Evidence of Residence in  
○ Censuses, City Directories and Yearbooks & more...  
○ at Ancestry, MyHeritage or FamilySearch. 

● Look at other family Genealogies at Ancestry, FamilySearch, MyHeritage 
 

https://prf.hn/click/camref:1101l4aFW/creativeref:1100l28566
https://www.familysearch.org/en/
https://www.myheritage.com/family-tree-builder
https://www.census.gov/
https://www.findagrave.com/
https://billiongraves.com/
https://chroniclingamerica.loc.gov/
https://www.findagrave.com/
https://billiongraves.com/
https://prf.hn/click/camref:1101l4aFW/creativeref:1100l28566
https://www.myheritage.com/family-tree-builder
https://www.familysearch.org/en/
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STEP FIVE 

SOCIAL MEDIA 
 
Social Media is a great place to find surname groups, location groups, special interest 
groups (like DNA) history groups, genealogy or historical society pages... all there to help 
share information about the families and locations you’re searching   
 
Just go to your favorite social media outlet and search for the surnames or locations you’re 
researching.  You might just find a surname group where you can connect with others.  I 
recommend starting with Facebook. That’s where I have the most success.  

 
Social media places to look: 
○ Facebook Genealogy Groups 
○ Pinterest Family Groups 
○ Instagram 
○ Readit 
○ YouTube 
○ Blog posts on places like Blogger.com. 
 

Consider starting your own Facebook group to share your family 
history discoveries with family and friends. You can make them 
public or private. I have several of these where we share photos, 
stories and memories.   
 
If you do create a social media page, remember to capture those 
stories for your family history archives on your computer.  Don’t 
rely on Facebook to be your family history archive forever. 
 
They’re also a great way to write and share mini articles about 
your family, complete with pictures. Save these stories in one 
document, as it might become your genealogy book! 
 
Also, don’t forget search your ancestors with Google.  You never 
know where it may lead you. 
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BONUS TIPS 
 

Bonus Tip #1  

Free Trials 
 
Now that you’ve come this far and you’ve created a “list 
of records for further investigation”, now is the time to 
turn on some free trials.  As a reminder, that list… is the 
list of records you couldn’t access because they were 
behind the paywall or a subscription was required at 
Ancestry or other services.  Now with a free trial, you 
should be able to get to those records. 
 
In some cases, you’ll have that free trial for 14 days and for some for one month.  I suggest that 
you only use one free trial at a time starting with Ancestry.com.  When that free trial is over, you 
can move on the next service. 
 
When you start most free trials, you’ll be required to give them a credit card, although it won’t be 
charged until your free trial expires.  
 
If you choose not continue with the subscription, you’ll need to cancel it before your free trial 
ends or it will automatically convert to a paid account and charge your credit card.  
 
In the case of Ancestry.com, you’ll have 14 days to use it. Should you decide to cancel within 
the 14-day Free Trial, you can do so by going to your account and clicking the “cancel” link 
below your account profile. 
 
Well now that you have your ducks in a row, you can use free trials to explore the services for a 
few weeks and gather the records you wanted.   
 
Be sure to download those records to your computer during the free trial.  If you pause or cancel 
your subscription, you may not be able to see those records again in your free tree. Once you 
stop the free trial (without paying for it), the records will remain linked to your ancestors within 
your family tree. Should you decide to opt-in again (and pay for it this time), the records will be 
visible again.  Typically you’ll only get one free trial per company, per email address.  Make the 
most of it. 
 
Know that records you upload to the gallery in the ancestor profiles will remain visible 
regardless of your subscription status. 
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Here are my suggestions for free accounts and FREE TRIALS!   
 
Full disclosure, two of these are the Genealogy TV affiliate links. Should you become a paid 
member through the Ancestry or the MyHeritage link, Genealogy TV will make a few pennies.  I 
really appreciate you using affiliate links whenever possible. Every little bit helps support the 
Genealogy TV platform, so that I can continue to bring free educational resources to you. There 
is no extra cost to you by using affiliate links. 
 

• To get started with a FREE TRIAL at Ancestry GO HERE  
• FamilySearch.org is always free. Just go there and register. 
• To get started with a FREE TRIAL at MyHeritage.com - Complete Plan  

 

BONUS TIP #2   

Download Your Family Data and 
Upload it to Another Service 
 
 
Once you’ve got these previous steps started 
and have created a foundation of your tree, 
consider downloading your Gedcom File from 
Ancestry and upload it to MyHeritage and 
FamilySearch (for free at the time of this writing).   
 
By doing so, you’ll get the hint features for the records on the other services.  I estimate that 
you’ll find about 10-15% of the same records on both services. However, you may discover new 
records, new member trees to explore, and possibly meet some new cousins. 

 
   Downloading your Gedcom file from Ancestry is 

easy. Simply go to the tree settings on Ancestry, 
click Export Tree, when it’s done generating the 
file, you can click download.  Just remember 
where you saved it.  Don’t try to open it.  You’ll 
then use that same file and upload to one of the 
other services. 

 
• To upload a Gedcom file to FamilySearch.org go here. 
• To upload a Gedcom file to registered MyHeritage.com users go here.  

 
 

https://prf.hn/click/camref:1101l4aFW/creativeref:1011l28781
https://www.familysearch.org/en/
https://support.ancestry.com/s/article/Uploading-and-Downloading-Trees
https://www.familysearch.org/mytrees/
https://faq.myheritage.com/en/article/how-do-i-import-a-gedcom-file-in-family-tree-builder
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BONUS TIP #3   

FREE RESOURCES FROM GENEALOGY TV! 

You can always find free educational resources here at Genealogy TV where you’ll find multiple 
platforms to keep you informed. 

Free video education on YouTube.com/GenealogyTV!  

At Genealogy TV, you’ll find free videos on the YouTube 
channel for beginners to advanced genealogists.  There are 
several programs produced there.  Typically, there is a new 
video every Friday morning.  These are usually either a 
“footnotes” or “In Search of Your Family Tree”.   

● The “footnotes” program is interviews with experts in
their field. “It’s called footnotes, because it’s in the
footnotes where the real sources are!”

● “In Search of Your Family Tree” is designed to educate
you about the records, resources and how to use…
various software and navigate websites to aid you in
your research.

● “Tiny Tip Tuesday’s” comes out… you guessed it… on
Tuesday’s in a short form video as information
becomes available.

● “Genealogy TV Live” is the live show where viewers
can ask questions in the chat window.  It’s just like live
television, only it’s on YouTube and is specifically
designed for live interaction with the audience.

Times for the live show vary and are promoted to subscribers of the Genealogy TV
Newsletter, Facebook page, and the Genealogy TV YouTube Channel in advance.

https://www.youtube.com/genealogytv
https://www.youtube.com/watch?v=LaeK3GLbCsM&list=PLiMXWjHlj5RQkfzPD0ejKCv8GGJHp7wVy
https://www.youtube.com/watch?v=kOd7WC5fhec&list=PLiMXWjHlj5RTNKxJ1rZ4aNGMphmzmS0TY
https://www.youtube.com/watch?v=LaeK3GLbCsM&list=PLiMXWjHlj5RQkfzPD0ejKCv8GGJHp7wVy
https://www.youtube.com/watch?v=kOd7WC5fhec&list=PLiMXWjHlj5RTNKxJ1rZ4aNGMphmzmS0TY
https://www.youtube.com/watch?v=fv9vpbktRhs&list=PLiMXWjHlj5RQV5H9FYyoCDVd3-TB-Ik_Z
https://www.youtube.com/watch?v=ltjRz4rE1oU&list=PLiMXWjHlj5RT1cYMdDIaoMz73fJOxYvr-
https://mailchi.mp/a0862c6473aa/genealogytvnewsletter
https://mailchi.mp/a0862c6473aa/genealogytvnewsletter
https://www.facebook.com/Genealogytv/
https://www.youtube.com/genealogytv
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Free resources on GenealogyTV.org.  

Here is where everything resides.  
There is a blog post for every video 
episode since February of 2018. If 
there is additional information about 
each episode, this is where it will 
be.   
Sign Up for the Free Newsletter.  
Each time there is a new video 
released, you can be notified by 
signing up for the newsletter HERE. 

Genealogy TV Insiders is group or individual coaching. These 
are conducted through virtual Zoom meetings and do have a 
fee.  For more information about coaching sessions, go to 
https://genealogytv.org/insiders/. 

DONATIONS are always welcome.  You can use your credit card or Paypal account
at paypal.me/ConstanceKnox.  You do not need to have a Paypal account to use your credit 
card. I really appreciate it.  

Lastly, for North Carolina researchers, check out the 
NCAncestry.com and NC Ancestry on YouTube. 

That’s a Wrap! 
Whew! That was a lot of information to digest.  Don’t let the project be overwhelming.  Take it a 
little bit at a time. Your ancestors aren’t going anywhere. They’ll be here when you get back to 
the project. 

I hope that helped inspire you to chase your curiosity.  Whatever question you had that brought 
you to start this genealogical journey… is your first research question… of many to come. 

Enjoy the journey! 

Connie Knox 
A Lifelong Genealogist 
Here to help you go further, faster, and factually with your family research! 

https://genealogytv.org/
https://mailchi.mp/a0862c6473aa/genealogytvnewsletter
https://genealogytv.org/insiders/
https://www.paypal.me/ConstanceKnox
https://ncancestry.com/
https://www.youtube.com/channel/UCwOIg2lTv7ifY_AEitw7L-g?view_as=subscriber


 
 

 
 

From the Video #1 Way to Break Down Brick Walls (Updated 2020) 
By Constance Henley Knox 

 
There is no doubt that using the Friends, Associates, and Neighbors1 (a.k.a. the FAN Club or 
Cluster Research), helps us tie the family and records together. This helps us confirm that we 
have the right people, in the right place, with the right records. 
 
To prove our links between family members we must conduct “Reasonably Exhaustive 
Research.”2 Part of that research is often reviewing the neighbors who lived around our 
ancestors.  This can be found in census records (as one source). 
 
To make the process easier, I have developed a trick to extract data from census records that 
surround your target ancestors.  This will allow you to filter your results to explore specific 
surnames in a variety of ways within the data set. Thus, allowing you to research the FAN Club 
of your “Target Ancestor.” 
 
Your Target Ancestor is a term I developed to help you stay focused on you mission of your 
Research Question.  Your Research Question should be written down to help you stay on track.  
 
Research Question = Who do you want to know more about, and what is it you want to know? 
 
Remember that Reasonably Exhaustive Research does not stop at the census records.  While this 
exercise is for census records, you should be exploring all records you can find to help prove 
your lineage and tell the stories of your ancestors. 

 
 

Step-By-Step Instructions for how to Extract Data from Census Records 
(Demonstrated on Ancestry.com) 

 
Step 1 
Open a new Excel spreadsheet, name it, and SAVE IT where you will find it again.  Do this 
before anything else.  Save it often throughout the process. Excel does not save automatically 
unless you turn autosave on for cloud saving. 
 
Step 2 Put the Header Information from the Census 
This is so you know where you got this information. Include a link to the image in your Excel file. 
 
  

 
1 Created by Elizabeth Shown Mills. 
2 Board for Certification of Genealogist, Genealogy Standards – Second Edition. (Nashville, Tennessee: Turner 
Publishing, 2019), 2. 



 
 

 

Step 3 Extracting the Data from the Census Record 
 

1. On Ancestry.com, find your “Target Ancestor” and a census record you want to 
extract. 

2. Note the image number you are looking at. 
3. Go 5 to 10 pages before your “Target Ancestor.” 
4. Click on the people icon (at the bottom) to open 

the transcriptions. 
5. Click anywhere in the transcriptions section. 
6. “Select All” data, by holding down the CTRL button 

on the keyboard + A (Windows) or CMD + A (on a Mac). This will highlight everything.  

7. Copy all the data with CTRL + C (Windows) or CMD +C (Mac). Or Right Click and 
choose Copy. 

8. Go to your new Excel spreadsheet. 
9. Select Cell B4. (Below the source information you entered in the top rows.) 
10. Right Click and choose Paste Special. 
11. When the Paste Special box pops up, (shown below) choose Text, click OK. 

  



 
 

 

 
12. Highlight all rows at the top you want to remove, right-click and choose “delete.” 

This will remove unwanted data and pull up the data in one click.  (Remember when you 
do this, to highlight the rows where the numbers are, not the cells.)  

13. In cell A1 type “Image.” 
14. In column A, note the image number from the Ancestry.com’s image on all lines 

pasted in each step. 
15. Drag the first image number by grabbing the handle in the lower right corner of the cell 

and drag down for the length of the data to identify this first set of data as being from 
image 1.  

16. Repeat these steps for 5 to 10 pages on either side of your Target Ancestor, 
adding them to the bottom starting in the B Column. This will capture as many 
neighbors as possible. 

17. Remember to note the image number each time you paste new data into your 
spreadsheet. The image numbers are important later. 

18. SAVE EARLY – SAVE OFTEN! 
 
  



 
 

 

Step 4 Locking and Formatting the Header Information. 
 
There are two ways, demonstrated in the video, to lock the column header information. One is 
to use the Freeze Panes option and the other is to use the Split option.  There are a variety of 
ways to use these tools.  Below is a recap of what was shown in the video. 
 
To lock just the top row: 

1. Select the data cell directly under the 
first column header on the left side 
where you want the headers to be 
locked. 

2. Go to the View Tab at the top of 
Excel. 

3. Select Freeze Panes, then select 
Freeze Top Row. 

4. Choose Unfreeze to remove the previous action from the same area. 
 
 
To lock more than just the top row, I use the Split function.  

1. Click the cell under the first column header where you 
want to split to begin. 

2. Go to the View Tab and choose Split. This should split 
the top five rows if you put your curser in cell A6 as 
shown here. 

3. To remove the split, toggle off the Split button again. 

  



 
 

 

Step 5 Filtering and Using the Spreadsheet. 
 
Now the fun begins.  Here is where we filter the columns so that we can 
research those Target Ancestors and FAN Club members, we are looking 
for. 
 

1. Highlight the column headers.  
a. (Unsplit the view if it gets confusing to see. You can always use the 

split again once the filters are turned on.) 
2. Go to the Home Tab and choose Filter.  

a. (If you don’t see the Filter button, you may need to customize the 
tools in the ribbon.)   

3. Using the down-arrow in each column header, you can now filter by 
surname or any other column where you set filters. 

a. Uncheck the Select All at the top of the filter box. 
b. Choose the items you want to filter by. 

4. NOTE:  REMEMBER TO UNFILTER EVERYTHING BEFORE YOU LEAVE. 
a. If you do not un-filter each column header, you may forget 

that it is filtered when you return.   
b. TRICK- To un-filter all columns at one time. 

i. Go to the Data Tab. 
ii. In the Sort & Filter area there is a Clear button that 

will clear all filters at once. 
5. REMEMBER TO SAVE YOUR DOCUMENT! 

Happy Hunting! 

Connie Knox 

 

 

https://support.microsoft.com/en-us/office/customize-the-ribbon-in-office-00f24ca7-6021-48d3-9514-a31a460ecb31
https://support.microsoft.com/en-us/office/customize-the-ribbon-in-office-00f24ca7-6021-48d3-9514-a31a460ecb31
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DNA - When Cousins Marry 
Endogamy vs. Pedigree Collapse for Genealogical Research 

By Constance Henley Knox 

This handout is from the video on Genealogy TV by the same name. I this video I interviewed 
Diahan Southard to discuss the differences between Pedigree Collapse vs. Endogamy and how we 
can determine these relationships within our family history. 

Definitions 
Centimorgans (cM) is a unit of measurement to determine the genetic distance between two 
relatives. The larger number of cM’s, the closer you are related.  See the Shared cM Project to see all 
possible relationships for any given cM’s you share with another DNA match. 

“Pedigree Collapse describes how reproduction between two individuals who share an ancestor 
causes the number of distinct ancestors in the family tree of their offspring to be smaller than it 
could otherwise be.” (ISOGG Wiki) 

“Endogamy is the practice of marrying within the same ethnic, cultural, social, religious or tribal 
group. In endogamous populations everyone will descend from the same small gene pool. People 
will be related to each other in a recent genealogical timeframe on multiple ancestral pathways and 
the same ancestors will, therefore, appear in many different places on their pedigree chart. 
Endogamy can be the result of a conscious decision or cultural pressure to marry within the 
selected group but also occurs as a result of geographical isolation (for example, in island 
communities).” (ISOGG Wiki)   

Diahan Southard says “Endogamy is when you have Pedigree Collapse over and over and over 
again.” 

ISOGG - International Society of Genetic Genealogy 

IBS vs. IBD  
IBS means Identical by State (or DNA from the general population).  
IBD means Identical by Descent (or DNA from our genetic relationships within our pedigree). 
  

https://youtu.be/Ilgl5707iP4
https://www.youtube.com/genealogytv
https://youtu.be/Ilgl5707iP4
https://dnapainter.com/tools/sharedcmv4
https://isogg.org/wiki/International_Society_of_Genetic_Genealogy
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Determine Endogamy 
Look for the longest shared segment. Segments longer than 20 cM’s is an indication there is no 
endogamy.  If you have a lot of cM’s in many smaller segments (less than about 20 cM’s), where you 
cannot find an identifiable long segment, you likely have an endogamous pedigree. Examples of 
endogamous population are some Jewish, Arcadian, Pacific Islanders or any population that were 
bound by geographic restrictions, such as an island.  

Determine Pedigree Collapse 
Look for ancestors that show up in two or more direct family lines.  I have found Wikitree’s fan 
chart can help visualize where you have duplicating ancestors in lines, indicating Pedigree Collapse. 

Pedigree Collapse only effects your DNA results if the cousins marrying cousins happens within 
recent generations.  You may also see this when two brothers marry two sisters.  There may be 
other variations too, like a man who has children from two different sisters. 

Two Relationships 
In some cases, you may find DNA matches may have two different of relationships. Shown in the 
video, Fred and Fiona were 2nd cousins and 4th cousins. Adding the average cM’s for both 
relationships (using the Shared cM Project) would give you the expected DNA range.  Compare the 
expected DNA range to the reported cM’s shown with DNA matches, should be within the expected 
range. 

WikiTree Fan Chart (not 
mentioned in the video)   

Using the WikiTree Fan 
chart, you can turn on 
colors to find repeating 
ancestors. The purple 
colors show where an 
ancestral couple repeats 
in my family.  Going down 
three generations, shows 
where my great 
grandparents Henry 
Henley and Nancy 
Winslow were 2nd 
Cousins.  As a result, there 
might be a slight increase 
in the cM count among the 
descendants from this 
couple. 

  

https://youtu.be/Ilgl5707iP4
https://dnapainter.com/tools/sharedcmv4
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AncestryDNA 
Ancestry uses the Timber Algorithm cuts off the pile-up regions that represents the general 
population and has no genealogical significance. This helps create better quality DNA matches.  You 
should also know that AncestryDNA no longer shows less than 8 cM’s DNA matches to reduce false 
positives. 

MyHeritage  
MyHeritage does not use AncestryDNA’s Timber algorithm and thus you may see additional smaller 
cM segments and a slightly higher overall cM count.  MyHeritage has an excellent Chromosome 
browser to help determine the longest segments. Use the One-to-One tool to see the shared 
segments between you and a DNA match. 

Shared cM Project – Briefly mentioned in this video, the Shared cM Project was created by 
Dr. Blaine Bettinger where he collected the number of centimorgans and calculated the various 
relationships among the test takers. The results have given us an unbelievably valuable tool that 
shows us the estimate range of centimorgans for each relationship.  

“Do Genealogy” as Diahan says... 
Remember to combine traditional genealogy along with DNA research to help prove your lineage. 

Diane Southard Your DNA Guide Blog  
Part 1 https://www.yourdnaguide.com/ydgblog/2019/7/26/pedigree-collapse-and-genetic-
relationships 

Part 2 https://www.yourdnaguide.com/ydgblog/2019/7/26/calculating-the-pedigree-collapse-
effect-in-your-dna-matches  

About Diahan Southard 
Your DNA Guide Founder Diahan Southard has been working in the 
genetic genealogy industry since its infancy. Both before and after 
earning a degree in microbiology from Brigham Young University, 
she worked for the Sorenson Molecular Genealogy Foundation, a 
major pioneer in creating a correlated genetic and genealogical 
database. 

Diahan is the author of Your DNA Guide- The Book ,  the ultimate step-by-step guide, 
do-it-yourself DNA manual. 

Your DNA Guide Website 

Your DNA Guide YouTube Channel 

  

https://dnapainter.com/tools/sharedcmv4
https://dnapainter.com/tools/sharedcmv4
https://www.yourdnaguide.com/ydgblog/2019/7/26/pedigree-collapse-and-genetic-relationships
https://www.yourdnaguide.com/ydgblog/2019/7/26/pedigree-collapse-and-genetic-relationships
https://www.yourdnaguide.com/ydgblog/2019/7/26/calculating-the-pedigree-collapse-effect-in-your-dna-matches
https://www.yourdnaguide.com/ydgblog/2019/7/26/calculating-the-pedigree-collapse-effect-in-your-dna-matches
https://amzn.to/3hnrXku
https://www.yourdnaguide.com/
https://www.youtube.com/channel/UCjPHyAuFrbQv0UwanJCRSNw
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Connie Recommends These DNA Books 
Your DNA Guide- The Book  by Diahan Southard 

The Family Tree Guide to DNA Testing and Genetic Genealogy by Blaine T. Bettinger  

Genetic Genealogy in Practice by Blaine T. Bettinger and Debbie Parker Wayne 

 

Connie Recommends These Other Genealogy TV Videos 
 

Grouping DNA Cousin Matches on Ancestry 

AncestryDNA Grouping Cousin Matches: Clarified 

Organizing DNA Cousin Matches using Excel Spreadsheets  

DNA Playlist on Genealogy TV 

 

https://amzn.to/3hnrXku
https://amzn.to/3hkHG3V
https://amzn.to/2Sv1EhZ
https://youtu.be/ErWHYCLjjxM
https://youtu.be/YOGarVcxLRQ
https://youtu.be/mlzAoiwSWIE
https://youtube.com/playlist?list=PLiMXWjHlj5RQ_iInPLinVtIxjyzn3yE4o
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FamilySearch and Ancestry 
Combined for Genealogy Research 

Video Link 

About Ancestry and FamilySearch 
Ancestry 
You should know that Ancestry.com is a paid service where 
you have individual trees. There are free records and 
indexes you can view without a subscription.  You can also set up a free guest account where you can 
build a tree. Learn more about what you can do with a free guest account here.  

Also, you can sign up for a 14 Free Trial at Ancestry (affiliate link) and see all the records behind the pay 
wall. This is a good strategy if you find something in the free indexes that warrants further investigation. 
You can always turn it off before the 14 days expire, to avoid charges to your credit card 

FamilySearch 
FamilySearch is a free service to everyone to use and uses 
one giant collaborative world tree. There are no individual 
trees on FamilySearch. Keep in mind, others working on the 
tree can change what you add to the tree, with reasons for the change. 

Both services have excellent records, some are unique, and some overlap. Therefore, using both 
together is a very powerful research strategy. 

Using Two Screens or Frames 
Consider using two screens or two 
windows (if you are working on one 
screen) to have both services open at 
the same time.  

Alternatively, you could have two 
browser tabs open (one for 
Ancestry.com and one for 
FamilySearch.org) and bounce back 
and forth between the two 
tabs/services as you research. 

https://youtu.be/xtHEDOPXKdo
https://www.ancestry.com/search/categories/freeindexacom/#collections
https://www.ancestry.com/search/categories/freeindexacom/#collections
https://www.ancestry.com/account/create/?_ga=2.26289853.1487889771.1636638115-919479033.1636638115
https://support.ancestry.com/s/article/Free-Registered-Guest-Accounts?language=en_US#:%7E:text=Because%20registered%20guest%20accounts%20are,with%20only%20one%20Ancestry%20account.
https://prf.hn/click/camref:1101l4aFW/creativeref:1011l28781
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Searching Census Records 
You may find that searching census records (or any images) that are hard to read, switching to another 
service may provide you a better view of the same image. Especially with government records like U.S. 
Census, I have found this to be helpful. Below is the same image on Ancestry and FamilySearch. Both 
have image adjustments, so make sure you see the tool icons to help read the images better. 

  

Searching Census on FamilySearch  
This is the process I used in the video for looking for a specific image in the U.S. Census on 
FamilySearch.org.  As a reminder from the video, the image on Ancestry was too light, so searching for it 
on FamilySearch (in this case) gave me a better image. 

1. FamilySearch.org > Search > Research Wiki > North America > United States > State > Census 
(Right side panel) > 1920 > FamilySearch Link > Search Name and an Event Date > Scroll Results 
to find your person. 

2. View the image. 
3. Adjust the contrast higher and the brightness lower to increase readability. 

Searching Census on Ancestry  
While not shown in the video, here is the process for doing the same search on Ancestry from the start. 
So, if you found a hard to read image on FamilySearch, try switching to Ancestry to see the same image. 

1. Search > Census and Voter Lists > Enter Name and an Event Date > Search > Filter to Year (if 
necessary) > Scroll List > Hover over list for mini view > Click View Image. 

2. Tool icon on right will open viewing options.  
1. Use Invert Colors to see a negative view.  
2. Use Enhance Image to add contrast. 

Searching Vital Records 
Civil Records 
Keep in mind that most birth and death certificates were not mandated in the U.S. until about 1909-
1912 (depending on the state). Marriage records date back to the mid 1800’s (depending on the state).  
Prior to this time, seek church records. 
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Vital Records on Ancestry 
Search Tab > drop down to Birth, Marriage & Death > Search by Name > Filter (left side) to record type > 
Search by Name > Use Auto Fill if person is already in your tree.  

In the video, searching for my ancestor’s death 
records on Ancestry, showed a FHL Film Number. This 
means Family History Library microfilm number.   

Family History Libraries are part of the Church of Jesus 
Christ of Latter-Day Saints. These libraries are available for 
everyone to use, regardless of religion.  

Over the years, the church has microfilmed millions of 
records and made available on FamilySearch.org for free 
(also created by the Church of Jesus Christ of Latter-Day 
Saints, a.k.a. the Mormons). 

Tip: From your ancestor’s profile on Ancestry, look at the Member Connect tab other members 
researching the same person. Then look at their trees > same ancestor > gallery to see if they have 
uploaded an image of a vital record.  You may find the same in leafy hints. 

Vital Records on FamilySearch 
1. Search > Records > under Find a Collection click on Browse All Collections > in left column under 

Collection Type choose Birth, Marriage, & Death > Filter (left side) to Location > Review list for 
possible record sets to 
review.  

2. Search the Record sets by 
name and event date. 

Note: The camera icon 
indicates the record collection 
has images. 

In my experience, I will often find vital records on 
FamilySearch that I can’t find anywhere else.   

Tip: From your ancestor’s profile on Ancestry, look at the 
Member Connect tab other members researching the same 
person. Then look at their trees > same ancestor > gallery to 
see if they have uploaded an image of a vital record.  You may 
find the same in leafy hints. 

3. On FamilySearch, Right-click and “Save as” the image to 
your computer. 

Death Certificate for William M. Smith 1923 
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Search Engines Are Different 
Using both Ancestry and FamilySearch to search for the same information will get drastically different 
results.  This is because some of the records they hold are different and because the search engines 
work differently.   

Try doing a search for one of your ancestors using the same exact information (name, event date, event 
place) to see your results. 

This does not mean that all results belong to your ancestor. However, they differences may provide new 
clues. 

On Ancestry 
Search > All Collections > Fill in the Fields > Search. 

If you use the autofill (for ancestors that are already in your Ancestry tree), consider removing extra 
data if you are not getting the results you desire. Sometimes too much information can filter out records 
you need. 

On FamilySearch 
Search tab > All Records > in top search box click More Options > Fill in fields > click Search. 

Card Catalogs Title Searches 
In this video we did a Title Search and a Keyword Search on both. Below are the steps I took for both of 
those searches. 

On Ancestry – Title Search 
Search tab > Card Catalog > Title Search.  

In my case I was searching for a book, but you could also search for a record set.   
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Be mindful that if you are searching for a record set and you don’t find what you are looking for, do the 
same search as a Keyword search instead. Title searches often need an exact title. 

Once you click into a record set or 
book, you may get a search box where 
you can search for your ancestor’s 
name. Note the quick links on the right 
side under “Browse this collection.” 

Be sure to try various spellings of your 
ancestor because the Optical 
Character Recognition (OCR) is looking 
at text and not for various spellings.  In 
my case, I had to change the name 
from “Henley” to “Henly” to find 
results.  

On Family Search - Title Search 
Search tab > Card Catalog > 
Titles > Fill in the Title Field > 
click Search. 

On FamilySearch, if the book is 
available, click through the link 
provided to see the images.  

Use the search icon at the 
bottom of the screen to bring up 
a search box to do an OCR 
search for your ancestor’s name. 
Just like on Ancestry, you need 
an exact spelling since this is an 
OCR search. 

Card Catalog Keyword Searches 
From the same card catalogs as shown above on either platform, try using keyword searches for the 
same information.  

In my experience, I have better luck with Keyword searches as opposed to Title searches on both 
Ancestry and FamilySearch. 

Try various keywords for different results. 

Thank You for Supporting Genealogy TV! 
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WikiTree 
Wiki Tree Video Link  

Summary 
This video and handout are about the basics of 
using WikiTree.com.  In the video, guest Mindy 
Silva explains how the WikiTree works and how 
to get started. 

WikiTree has over 27 million ancestor profiles 
(as of this writing) and is free to use, always.  It 
uses a collaborative tree run by a group of very 
dedicated and fun volunteers known as 
“WikiTreers.”   

WikiTree does not have records, but it does allow you to build a tree for free and connect your family to 
the collaborative tree.  Once connected you may find your family tree suddenly expands by several 
generations in several lines. 

WikiTree Honor Code 
At some point in your exploration and use of WikiTree, you will be asked to sign the Honor Code.  It is 
simple and designed to keep all users on the same page.   

Tags 
This is also where you can state the surnames you are researching or specific subjects in the Tags 
portion of the Honor Code.  You can add up to 20 tags. 

Getting Started 
Set up an account.  You can look at some features without signing up, but Mindy suggests you sign up. It 
is free. 

G2G (Genealogist to Genealogist) is the place to go in their forum to get help.  Find it by going to the 
Help menu at the top right of the screen.  

https://youtu.be/eqUlQ0dxsgk
https://youtu.be/eqUlQ0dxsgk
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Search for Your Ancestors 
To search for your ancestors, you can do so right from the 
home page as shown.  Simply type your Ancestors Name in 

the green box and hit search.  
Alternatively, there is a search 
box at the top from almost 
anywhere on the WikiTree 
site. 

Once the results are shown, 
you can sort by birth or death dates. Then simply click on the person to see more in the Ancestors 
Profile.  

You may be asked to upgrade your account to the next level to add information to the tree. The upgrade 
is free. To learn more about benefits of membership, go here. 

WikiTree Ancestor ID’s 
Each ancestor as a WikiTree ID which can help in various search functions throughout the site.  You can 
see it next to the ancestors name and a convenient copy function when you click on the ID 

 

Ancestors Profile  
If your ancestors are found in 
search, there is no need to 
create a new profile. There is 
only one profile per ancestor 
at WikiTree.  Anyone can 
update the profiles like any 
wiki. You will need to provide 
record or DNA sources (even if 
your personal knowledge, is 
the source) when updating or 
adding information.  

Explore the Edit, Images, 
Family Tree & Tools, and all 
tabs across the top of the 
profile to see what you can do.  

https://www.wikitree.com/wiki/Help:Membership#Wiki_Genealogists
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Adding Information 
Under the Edit tab (from the profile) is where you can add dates and places, parents and more. 

 

As you add information, you may see a popup screen showing other ancestors in the tree that might be 
a match.  If you see your ancestor in the popup screen, you will want to connect that profile to avoid 
duplicating the same ancestor in the WikiTree. 

Citing Source 
WikiTree provides examples of source citations if you want to use them.  To find them go to Help (at the 
top right) and drop down to Sources. 

DNA 
You can add your DNA kit numbers from other services. WikiTree does not upload DNA but you can 
make references to where your DNA kits are located. 
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Gedcom Uploads 
You can upload a Gedcom from another services. You will need to go through each individual one at a 
time. 

Relative Finder 
You can find how you are related to anyone in your tree or how any two people are related by going to 
the Relationship Finder.  To get there go to your profile ID in the top menu (like Knox-1234) and click on 
that to get a menu, then drop down to Relationships.   

Alternatively, you can do the same from any other ancestors Profile and click on their Profile ID (like 
Smith-4567) and drop down to “Relationship to Me.” 

Another option is to use the Profile ID from any two ancestors to see how they are related to each 
other. 

 

How to See Sources for a Profile in the WikiTree 
Click into a profile, at the bottom is a list of sources. Often you will find link directly to the source. 
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See Changes of All Working on a Profile 
Changes are tracked in the Changes tab from any profile.  This will help when collaborating with others 
and to meet new cousins! 

 

Adding Images 
In any profile, click on the Add New link. Do not forget to 
add the source or give credit to who provided the original 
image.  

Projects 
You can see special projects on specific subjects by 
clicking on the Find tab and dropping down to Projects. 

Thanks 
Special Thanks to Mindy Silva for the interview and help 
with the WikiTree Challenge (in another episode) where I 
was the guest. 
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